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NI 9930 Motion Control Accessories User Guide

@ Note If you are a new user of LabVIEW or are unfamiliar with LabVIEW, refer to the Getting
Started with LabVIEW manual for information about LabVIEW and LabVIEW terminology.

This document explains how to use the NI 9930 motion control accessories with the NI 9512 C Series
drive interface module and selected position command servo drives.
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NI 9930M Motion Control Accessory for Mitsubishi Servo Drives

The NI 9930M motion control accessory allows easy connection between the NI 9512 C Series drive
interface module and the Mitsubishi MR-J2 or Mitsubishi MR-J3 servo drive.

What You Need to Get Started

You need the following items to get started.

Hardware

U NI 9930M Motion Control Accessory and NI 951x Y-cable.
(NI part number 781824-01)

U NI 9512 C Series stepper drive interface module.
(NI part number 779944-01)

U NI real-time controller and chassis that support the RIO Scan Interface.

@ Tip To determine if your controller and chassis support the RIO Scan Interface go to ni.com/
= info and enter rdsoftwareversion.

Q24 V power supply (such as the NI PS-15) for the CompactRIO controller.
(NI part number 781093-01)

@ Note Refer to the controller operating instructions for power supply requirements.
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24 V power supply (such as the NI PS-15) for the NI 9930M. This supply also powers the NI 9512
and any drive I/O.
(NI part number 781093-01)

Note Refer to the NI 9512 Operating Instructions and Specifications and the drive manual to verify
that the selected power supply meets the system requirements.

Ethernet connection and cable for the CompactRIO controller.

50- or 20-pin MDR cables to connect the accessory to the drive.

—  One 50-pin MDR cable for MR-J3 drives
(NI part number 194604-02)

—  Two 20-pin MDR cables for MR-J2 drive
(NI part number 194466-02)

Mitsubishi MR-J2 or MR-J3 position-command servo drive.

Servo motor, encoder, power supply, and associated cables to connect the motor and encoder to the
drive.

Software

a
a
a
a

LabVIEW 2009 SP1 or later

LabVIEW 2009 SP1 Real-Time Module or later
LabVIEW 2009 SP1 NI SoftMotion Module or later
NI-RIO 3.4.0 or later

Figure 1 shows a simplified connection diagram.

Host Computer

Ethernet
Cable

Screw Terminal Connectors

+24 V Power Supply CN1B Cable
(NI PS-15 Shown) (20-pin MDR)

N|§51X CN1A Cable &4
Y-Cable -pi B
./ (20-pin MDR) [yl Iy
NI RT Controller ' '
(NI cRIO-9014 shown) bt
and NI 9512 Module
Hhid —
) ——————— P2
NI 9930M Motion Mitsubishi MR-J2 2§
Control Accessory Servo Drive % 4ﬂ

Figure 1. NI 9930M Connection Accessory with to MR-J2 Drive Connections
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Figure 2. NI 9930M Connection Accessory with to MR-J3 Drive Connections
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Figure 3 shows an overview of the connectors on the NI 9930M connection accessory.
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Figure 3. NI 9930M Connection Accessory Connectors
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Hardware Installation and Configuration

Step 1: Set Up the CompactRIO System

Complete the following steps to set up the CompactRIO hardware.

1. Install the real-time CompactRIO controller on the chassis if you are not using an integrated
controller and chassis.

@ Note Write down the controller serial number before installing the controller onto the chassis.
You will be unable to read the serial number after you install the controller.

a.  Make sure that no power is connected to the controller or the chassis.

b.  Align the controller with the chassis as shown in Figure 4.

1 Controller 4 Reconfigurable Embedded Chassis
2 Captive Screws 5 Grounding Screw
3 Controller Slot

Figure 4. Installing the Controller on the Chassis (Eight-Slot Chassis Shown)
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3.

c.  Slide the controller onto the controller slot on the chassis. Press firmly to ensure the chassis
connector and the controller connector are mated.

d. Using a number 2 Phillips screwdriver, tighten the two captive screws on the front of the
controller.

Connect the controller to a power supply and an Ethernet network on the same subnet as the
development computer. Refer to the controller operating instructions for information about wiring
the controller to the power supply and Ethernet network.

Note Do not plug in or turn on any power to the system until after you complete Step 3: Configure
the Drive and Connect the Motor and Encoder to the Drive.

Install the NI 9512 module in slot 1, 2, 3, or 4 of the chassis.

Step 2: Connect the NI 9930M Connection Accessory
The NI 9930M connection accessory contains connections for the NI 9512 C Series module, the
Mitsubishi MR-J2 or MR-J3 servo drive, and a 24 V power supply for NI 9512 module and drive I/O.

1.
2.

g & @

Connect the NI 9512 module to the NI 9930M J4 connector using the NI 951x Y cable.

Connect the NI 9930M to the drive.

o Mitsubishi MR-J2—Connect the J2 connector to the CN1A connector on the drive, and the
J6 connector to the CN1B connector on the drive using two 20-pin MDR cables.

o Mitsubishi MR-J3—Connect the J3 connector to the CN1 connector on the drive using one
50-pin MDR cable.

Connect a 24 V power supply to the Vsup and COM terminals on the NI 9930M accessory J8

connector. Figure 3 shows the location of the power supply input.

Connect pin 2 (EMG - emergency stop input signal) and pin 1 (COM) to an emergency stop switch.
Refer to the drive manual for more information about emergency stop switch requirements.

Note If the emergency stop functionality is not required, connect the EMG input directly to COM
to bypass any external safety circuitry.

Note You cannot enable the drive if you do not connect the EMG input to an emergency stop switch
or directly to COM.

Connect pin 15 (LSP - forward rotation stroke end/forward limit) and pin 14 (LSN - reverse rotation
stroke end/reverse limit) to pin 13 (COM), or configure the drive to ignore limit inputs.

Note These configuration settings disable limits for initial setup and testing purposes. National
Instruments recommends connecting and enabling limits in your final application. Refer to the drive
documentation for limit input requirements.

Connect pin 9 (COM) to pin 10 (LG - control common).
Note Not connecting pin 9 and pin 10 will result in unpredictable behavior.

Connect any additional I/O, such as limits, DIO, position compare outputs, position capture inputs,
and so on, using the NI 9930M screw terminal connectors. The J1 and J5 connectors allow
connection to the drive I/O signals, and the J7 connector provides connection to the NI 9512 1/O
signals. Refer to the drive or the NI 9512 module documentation for specific signal connection
requirements.
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Figure 5 shows the screw terminal connector pinouts.
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Figure 5. NI 9930M 1/0 Connectors
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Step 3: Configure the Drive and Connect the Motor and Encoder to the Drive
This section covers the minimum drive settings and connections to allow the motor to move. Refer to
the drive manual for additional information about drive parameters and signal information.

1.

4.

5.

Power on the drive and configure the drive for position control mode. These parameters differ
depending on the drive. Refer to the drive manual for information about how to set drive
parameters.

¢ Mitsubishi MR-J2—Set parameter P 21 to 1 (signed pulse train).

¢ Mitsubishi MR-J3—Set parameter PA 01 to O (position control) and PA 13 to 1 (step and
direction). You may also need to set parameter PA 05 (pulses per rev) to the appropriate setting
for your encoder.

Ensure that the drive encoder output pulses and electronic gear parameters are set to the default
values:

Mitsubishi MR-]J2

a.  Set parameter P 27 to 4000 pulses per rev. If you change this from the default value, you must
also change the value specified for the encoder Counts per rev in Step 3: Configure the
NI 9512 C Series Module of the Software Installation and Configuration section.

b.  Set parameter 3 and parameter 4 to 1. This disables any electronic gearing settings.
Mitsubishi MR-J3

a.  Setparameter PA 15 to 4000 pulses per rev. If you change this from the default value, you must
also change the value specified for the encoder Counts per rev in Step 3: Configure the
NI 9512 C Series Module of the Software Installation and Configuration section.

b.  Set parameter PA 05 to 0. This disables the number of command input pulses per servo motor
revolution parameter.

c.  Set parameter PA 06 and parameter PA 07 to 1. This disables any electronic gearing setting.

Connect the motor and encoder to the drive. Refer to the documentation specific to your drive for
motor and encoder connection information.

Tip An incorrectly connected encoder may cause NI SoftMotion to return error -77076
(NIMCDM_driveReadyNotActiveError). Verify the encoder connections if you see this error.

Connect the drive power. Refer to the drive documentation for power connections and
specifications.

Apply power to all the hardware once all connections are made and continue to the next section.

Software Installation and Configuration

This section covers installing and configuring the software for the NI 9512 C Series drive interface
module. It assumes that all required software from the What You Need to Get Started section is installed.

5

9

Step 1: Install Software on and Configure the NI RT Controller

Complete the following steps to configure the controller and install software on it.

1.

2.

Note The Measurement & Automation Explorer (MAX) user interface may not match these steps
exactly depending on which version of MAX you are using.

Launch MAX on the development computer by clicking the MAX icon on the desktop, or by
selecting Start»All Programs»National Instruments»Measurement & Automation.

Select the controller under Remote Systems in the Configuration pane. If you do not see the
controller, you may need to disable the firewall on the development computer. Go to
ni.com/info and enter RIOMAXTroubleshoot for more information.

NI 9930 Motion Control Accessories User Guide 8 ni.com



10.

11.

12.

13.

14.

15.

16.
17.
18.

19.
20.

Verify that the Serial Number in the General Settings section matches the serial number on the
device.

If you do not want to format the disk on the controller, eliminating all installed software and files,
skip to step 14.

Set the Safe Mode switch on the controller to the On position.

Power on the controller. If it is already powered on, press the Reset button on the controller to
reboot it.

Right-click the controller under Remote Systems in the Configuration pane in MAX and select
Format Disk.

(Optional) Enable the Keep Network Settings checkbox if you want to retain the same target name
and IP address.

Click Format to start formatting the disk.

When MAX finishes formatting the disk, set the Safe Mode switch to the Off position and click
OK.

Select the System Settings tab and type a descriptive name for the system in the Hostname field.

(Optional) Complete this step only if the target has an empty IP address (0.0.0.0). Select the
Network Settings tab and select DHCP or Link Local from the Configure IPv4 Address list to
assign an IP address or select the Static to specify a static IP address in the IPv4 Address section.

Click Save on the toolbar and let MAX reboot the system.

‘When the new system name appears under Remote Systems, expand the controller item in the tree,
right-click Software, and select Add/Remove Software.

Select a recommended software set that includes NI-RIO 3.4.0 or later.

Note If you are using the NI SoftMotion Module 2010 SP1 or earlier, also select LabVIEW
NI SoftMotion Module Scan Engine Support from the list.

Click Next.
Select LabVIEW NI SoftMotion Module from the add-ons list.

Click Next to install the selected software on the controller. Click Help if you need information
about installing recommended software sets.

When the software installation completes, click Finish to reboot the controller.
Close MAX.

Step 2: Creating a Project and Adding an NI SoftMotion Axis
Complete the following steps to create a LabVIEW project.

1.
2.

Launch LabVIEW by selecting Start»All Programs»National Instruments»LabVIEW.

Click the Empty Project link in the Getting Started window to display the Project Explorer
window. You can also select FilexNew Project to display the Project Explorer window.

Select Help and make sure that Show Context Help is checked. You can refer to the context help
throughout the tutorial for information about items on the block diagram.
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4. Right-click the top-level project item in the Project Explorer window and select New»Targets
and Devices from the shortcut menu to display the Add Targets and Devices dialog box. Refer to

Figure 6 for more information.

I3 Project Explorer - Urtitied Project 1 *

ol s

Expand &ll

Properties

Collapse All

Eile Edit Miew Project Operate Tools Window Help

S| st | @m-¢ o]

Items | Files

= My Compu
% Depends  Save Targets and Devices, ..
i BuildSp  Save As. S

Save All (this Project)
View »
Find Items with Ne Callers

Find Missing lems
Find Items Incerrectly Claimed by a Library
Find Project kems...

Figure 6. Adding a New Target

Expand Real-Time CompactRIO.

® N W

Make sure that the Existing target or device radio button is selected.

Select the CompactRIO controller to add to the project and click OK.
If you have LabVIEW FPGA installed, the Select Programming Mode dialog box appears. Select

Scan Interface to put the system into Scan Interface mode, then click Continue.

Tip

Use the CompactRIO Chassis Properties dialog box to change the programming mode in an

existing project. Right-click the CompactRIO chassis in the Project Explorer window and select
Properties from the shortcut menu to display this dialog box.

9. Click Discover in the Discover C Series Modules? dialog box if it appears.

10. Click Continue.

NI 9930 Motion Control Accessories User Guide
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11. Right-click the controller item in the Project Explorer window and select Properties from the
shortcut menu to display the RT Target Properties dialog box. Select Scan Engine from the
Category list to display the Scan Engine page.

12. Set the Scan Period to 10 ms or lower, then click OK to close the RT Target Properties dialog
box.

13. If you did not reformat the CompactRIO device in Step 1: Install Software on and Configure the
NI RT Controller, expand the real-time target. If an axis already exists on the target, right-click the
axis and select Remove from Project, or temporarily associate it with different hardware using the
Axis Manager dialog box. You cannot associate two axes with the same hardware device. Refer to
Figure 8 to view a project with an axis on the target.

14. Right-click the controller item in the Project Explorer window and select New»NI SoftMotion
Axis from the shortcut menu to open the Axis Manager dialog box, shown in Figure 7.

15. Click Add New Axis to create an NI SoftMotion axis associated with the NI 9512 module. Axes
are automatically bound to an available module. You can double-click the axis name to rename the
axis and give it a descriptive name.

& Axis Manager
Axis Name Bound Hardware
fixis 1 Mod1 (Slat 1, NI 9512)
Add Mew Axis l l Change Einding ] [ Delete Axis l l Mawve Up ] Move Dawn
[ [0]4 ] [ Cancel ] [ Help

Figure 7. Axis Manager Dialog Box
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16. Click OK to close the Axis Manager dialog box. The new axis is added to the Project Explorer
window.

E Note You cannot associate more than one axis with the same C Series module.

When you have finished these steps your LabVIEW project should look similar to the image in
Figure 8.

ﬁpruject Explorer - Untitled Project 2 E]@

File Edit Miew Project Operate Tools \Window Help

EEE IR R

Items | Fies

= [l Project: Untitled Project 1
= B My Computer
"' Dependencies
% Build Specifications
cRIO-9012(10.0.67.48)
+ [ Chassis (cRIC-9104)
L Axis 1 (Madt (Slot 1, NI 9512))
"' Dependencies
"%, Build Specffications

Figure 8. Project Explorer Window with Modules in Scan Interface Mode

Step 3: Configure the NI 9512 C Series Module
Complete the following steps to configure the axis I/O settings for use with the Mitsubishi MR-J2 or
MR-]3 servo drive.

1. Right-click the axis in the Project Explorer window and select Properties from the shortcut menu
to open the Axis Configuration dialog box.
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Figure 9 shows the parts of the Axis Configuration dialog box for NI 9512 C Series module.

1 fodis Configuration @
General Settings Trajectory Spline Stepper
- + —
la}—{~]© =l
Limits & Home Capture Encoder
I — a0 e
Digltal /O
anr et Vi
—_—
Drive Enable Compare
>] [y

Figure 9. Axis Configuration Dialog Box

@ Note The Axis Configuration dialog box user interface may not match this image exactly
depending on which version of the LabVIEW NI SoftMotion Module you are using.
2. On the General Settings page set the Loop Mode to Closed-Loop.
3. Click the Encoder button and configure the Units and Counts Per Unit.
a. Make the following changes in the Active State section:

e Set the Line State for A to High.
e Set the Line State for B to Low.
e Set the Line State for Index to High.

&

b. In the Index Reference Criteria section set the Line State for A and B to Inactive.
c.  Type rev in the Units text box.

d.  Set the Counts per rev to 4000. This assumes the default drive setting for encoder pulses per
rev. Refer to Step 3: Configure the Drive and Connect the Motor and Encoder to the Drive in
the Hardware Installation and Configuration section for more information.
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When you are finished the Encoder Settings page will look similar to Figure 10.

Encoder
Section Display Units Active State A
Units Line Stake A B Index A : J
Encoder Yelocity rev ] High ® O @ ]
Low O @ 0 B || L

Counts Per rev :
4000.000000%] Index L

Index Reference Criteria

Encoder Yelocity
1000000 || countsfs

Line State
Active

Inactive

@O0 =

B
@]
(O]

[ OF ] [ Cancel ] [ Apply ] [ Help

Figure 10. Axis Configuration Encoder Page

settings:

a.  Set Output Mode to Step and Direction.
b. Set Output Type to Differential.

c.  Set Active State to Low.
d

@ " 4.  Click the Stepper button to open the Stepper page. Configure the stepper output and steps per rev

Set Steps Per rev depending on the encoder resolution. For example, if you are using an

encoder with 131,072 pulses per revolution, set Steps Per rev to 131,072.
When you are finished the Stepper Settings page will look similar to Figure 11.

Stepper
Stepper Outpuk
Section Active Inactive
Cutput Type Ackive State
Stepper Differential v Low v o
Pasition Errar Qutput+
COM
Correction Profile Units Steps Per rev
Vs
rey 131072,000000 5 Output-
= com
Cutput Mode
Forward Reverse
(%) Step and Direction
Step
O Clockwise | Counterclockwise Diraction
[ OF ] [ Cancel ] [ Apply ] [ Help

Figure 11. Axis Configuration Stepper Page
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e. In the Position Error section, change the Position Error Limit to an acceptable value for
your system. Exceeding the specified position error limit causes NI SoftMotion to disable the
drive and turn off the Drive Enable signal.

5. Click the Digital I/O button to open the Digital I/O page and map the following status inputs.
Jr a.  Map DI 1 to Servo/Drive Ready. This signal is active when the drive is enabled.

1) Double-click the text in the Mapping column and select Servo/Drive Ready from the
dropdown list.

2) Ensure that the DI 1 settings match the following:
¢ Input Type—Sourcing
e Active State—On
«  Digital Filter—50 ps

b.  Map DI 2 to In-Position. The In-Position signal from the drive is active when the current
position is within a user-specified distance from the target position. This is a drive setting.

1) Double-click the text in the Mapping column and select In-Position from the dropdown
list.

2) Ensure that the DI 2 settings match the following:
¢ Input Type—Sourcing
e Active State—On
*  Digital Filter—50 ps

c.  Map DI 3 to Drive Fault/Alarm. When the Drive Fault/Alarm signal is active, the module
does not generate command signals.

1)  Double-click the text in the Mapping column and select Drive Fault/Alarm from the
dropdown list.

2) Ensure that the DI 3 settings match the following:
¢ Input Type—Sourcing
e Active State—Off
*  Digital Filter—S50 ps

d. (Optional) Configure a digital output to use for the Alarm Clear signal, if required. Position
command drives often require an Alarm Clear signal from the module to the drive. This signal

clears the alarm or fault outputs on the drive. This functionality is not available using a

mappable digital output. However, you can use a digital output to implement this functionality

in your code. Complete the following steps to use a digital output as an Alarm Clear output:

1) Determine the required pulse time and active state for the Alarm Clear signal. This
information is in the specifications for the position command drive.

2) Select an available digital output.

3) Configure the digital output Active State, Safe State, and Output Type as required by
the drive.

4) Inyourapplication VI add code to pulse the digital output line for the appropriate amount
of time to clear the alarm output. Do not clear the alarm on the drive until the alarm
condition is resolved.

@ Note If you are configuring a digital output to use as the Alarm Clear signal, you must connect the

configured output from the J7 screw terminal connector to the drive Clear signal on the J1 screw
terminal connector.
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When you are finished the Digital I/O Settings page will look similar to Figure 12.

Digital I/0
D1 3 Settings
Pin Mapping

DI O (MDR Fin 43 Mak Mapped Input Type Active Inactive
DI1(DSUBPInE) | ServofDrive Ready Sourcing [ Vaup {poemal Ve, e
DIZ(DSUBPFin4) | In-Position Active State Clreuit

Off v ; ="
| — H Input
DO 0 {DSUE Pin 113 | Mot Mapped R i

Digital Filker H
DO 1 (DSUB PN 5) | Mot Mapped s - el Y oy
= Hardware | oM Hardware W COM
[ [o]'4 ] [ Cancel ] [ Apply ] [ Help

Figure 12. Axis Configuration Digital I/0 Page

to be used as a criteria for move complete. When this signal is included in the move complete
criteria, the move is only complete if the In-Position signal is active.

6. Open the Trajectory page and enable the In-Position checkbox. This allows the In-Position input
[ 7.  Click the Drive Enable button and configure the Drive Enable output settings.

a. Place a checkmark in the Enable checkbox.

b.  Set Output Type to Sinking.
c. Set Active State to On.
d. Set Safe State to Off.

8.  Complete the following additional steps if you do not have limits and home connected at this time:
I IIII a.  Open the Limits & Home page.

b. Inthe Forward Limit and Reverse Limit sections ensure that the settings match the
following:

@ Note These configuration settings disable limits for initial setup and testing purposes. National
Instruments recommends connecting and enabling limits in your final application.
¢ Clear the Enable checkbox from both Forward Limit and Reverse Limit.

¢ Set the Active State for both Forward Limit and Reverse Limit to Off. This prevents
a limit warning even though limits are turned off.

c.  Open the Home section and clear the Enable checkbox.

9. Configure any additional I/O settings according to your system requirements, such as position
compare or position capture signals.

10. Click OK to close the Axis Configuration dialog box.

11. Right-click the controller item in the Project Explorer window and select Deploy All to deploy
the axis information.

12. Click Apply in the Conflict Resolution dialog box when it appears. The NI Scan Engine must be
in Active mode to move the axis.

13. Select File»Save Project to save the project.
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Step 4: Enable and Test the Drive Using LabVIEW

Use the Interactive Test Panel to test and debug your motion system and configuration settings on the
selected axis. With the Interactive Test Panel you can perform a simple straight-line move and monitor
feedback position and position error information, move and I/O status information, change move
constraints, get information about software errors and faults, and view position or velocity plots of the
move.

Complete the following steps to test your setup after configuring the axis using the Axis Configuration
dialog box.

1. Right-click the axis in the Project Explorer window and select Interactive Test Panel from the
shortcut menu.

2. On the Move tab set Target Position to 25 revolutions.

On the Move Constraints tab set Velocity to 1 revolution/sec. Using the encoder counts per
revolution and stepper steps per revolution values specified in this tutorial the motor will move
25 revolutions at 60 RPM. Click the Help button for detailed information about the items available
in this dialog box.

4.  Click the Enable button to enable the drive.
5. Click the Start button on the bottom of the dialog box to start the move with the configured options.
6.  Use the Status and Plots tabs to monitor the move while it is in progress.

Finalize your motion system setup by connecting and configuring additional I/O such as limits as
required by your system using the screw terminal connectors on the NI 9930M accessory.
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NI 9930P Motion Control Accessory for Panasonic Servo Drives

The NI 9930P motion control accessory allows easy connection between the NI 9512 C Series drive
interface module and the Panasonic Minas A or Minas AS servo drive.

What You Need to Get Started

You need the following items to get started.

Hardware

U NI9930P Motion Control Accessory and NI 951x Y-cable.
(NI part number 781823-01)

U NI 9512 C Series stepper drive interface module.
(NI part number 779944-01)

U NI real-time controller and chassis that support the RIO Scan Interface.

@ Tip To determine if your controller and chassis support the RIO Scan Interface go to ni.com/
info and enter rdsoftwareversion.

U 24 V power supply (such as the NI PS-15) for the CompactRIO controller.
(NI part number 781093-01)

@ Note Refer to the controller operating instructions for power supply requirements.

U 24 V power supply (such as the NI PS-15) for the NI 9930P. This supply also powers the NI 9512
and any drive 1/O.
(NI part number 781093-01)

@ Note Refer to the NI 9512 Operating Instructions and Specifications and the drive manual to verify
that the selected power supply meets the system requirements.

U Ethernet connection and cable for the CompactRIO controller.

U 50-pin MDR cable to connect the accessory to the drive.
(NI part number 194604-02)

U Panasonic Minas A or Minas A5 position-command servo drive.

@ Note The Panasonic Minas A drive product numbers start with MxDA, and the Panasonic Minas A5
drive product numbers start with MxDH.

U Servo motor, encoder, power supply, and associated cables to connect the motor and encoder to the
drive.

Software
1  LabVIEW 2009 SP1 or later

1  LabVIEW 2009 SP1 Real-Time Module or later
W LabVIEW 2009 SP1 NI SoftMotion Module or later
Q

NI-RIO 3.4.0 or later
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Figure 13 shows a simplified connection diagram.

Host Computer

Screw Terminal Connectors

NI 951x

NI RT Controller
(NI cRIO-9014 shown)
and NI 9512 Module

Eesaasspagmaasal) o\
EEEEEECEREFEEEEEERRLE

NI 9930P Motion

Control Accessory

] or Minas A5
Servo Drive
(Minas A5 shown)

+24 V Power Supply
(NI PS-15 Shown)

Panasonic Minas A

Figure 13. NI 9930P Connection Accessory Connections
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Figure 14 shows an overview of the connectors on the NI 9930P connection accessory.
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1 J1, J4, and J5: User I/O Screw Terminal Connectors 5 J3: NI 9512 Connector

2 DS1:+5V Power LED (from NI 9512) 6 J2: Minas A or Minas A5 Connector

3 DS2: +24 V Power LED 7 W1, W2, W3, and W4: Step and Direction Input Jumpers
4 J6: + 24 V Power Supply Connector

Figure 14. NI 9930P Connection Accessory GConnectors
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Hardware Installation and Configuration

Step 1: Set Up the CompactRIO System

Complete the following steps to set up the CompactRIO hardware.

1. Install the real-time CompactRIO controller on the chassis if you are not using an integrated
controller and chassis.

@ Note Write down the controller serial number before installing the controller onto the chassis.
You will be unable to read the serial number after you install the controller.

a.  Make sure that no power is connected to the controller or the chassis.

b.  Align the controller with the chassis as shown in Figure 15.

1 Controller 4 Reconfigurable Embedded Chassis
2 Captive Screws 5 Grounding Screw
3 Controller Slot

Figure 15. Installing the Controller on the Chassis (Eight-Slot Chassis Shown)

c.  Slide the controller onto the controller slot on the chassis. Press firmly to ensure the chassis
connector and the controller connector are mated.

d. Using a number 2 Phillips screwdriver, tighten the two captive screws on the front of the
controller.
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2. Connect the controller to a power supply and an Ethernet network on the same subnet as the
development computer. Refer to the controller operating instructions for information about wiring
the controller to the power supply and Ethernet network.

@ Note Do not plug in or turn on any power to the system until after you complete Step 3: Configure
the Drive and Connect the Motor and Encoder to the Drive.

3. Install the NI 9512 module in slot 1, 2, 3, or 4 of the chassis.
Step 2: Connect the NI 9930P Connection Accessory

The NI 9930P connection accessory contains connections for the NI 9512 C Series module, the
Panasonic Minas A or Minas AS servo drive, and a 24 V power supply for NI 9512 module and drive I/O.
1. Connect the NI 9512 module to the NI 9930P J3 connector using the NI 951x Y cable.

2. Connect the NI 9930P J2 connector to the drive I/F (Minas A) or X4 (Minas AS5) connector using
the 50-pin MDR cable.

3. Configure the Step and Direction Input jumpers. The default setting, shown in Figure 16,
configures the step and direction inputs as low-speed S00K inputs. This setting is compatible with
either the Minas A or Minas A5 drive.

AN\

W1 w2 W3 w4

Figure 16. NI 9930P Step and Direction Input Jumper Default Configuration

The Minas A5 drive also supports high-speed 4M RS-422 step and direction inputs. To use these
inputs, move the jumpers to the bottom position.

A Caution The Minas A drive does not support high-speed RS-422 step and direction inputs. Do not
change the jumper setting when using the NI 9930P with a Minas A drive.

4. Connect a 24 V power supply to the Vsup and COM terminals on the NI 9930P accessory J6
connector. Figure 14 shows the location of the power supply input.

5. Connect any additional I/O, such as limits, DIO, position compare outputs, position capture inputs,
and so on, using the NI 9930P screw terminal connectors. The J1 and J4 connectors allow
connection to the drive I/O signals, and the J5 connector provides connection to the NI 9512 1/0
signals. Refer to the drive or the NI 9512 module documentation for specific signal connection
requirements.
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Figure 17 shows the screw terminal connector pinouts.
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Figure 17. NI 9930P I/0 Connectors

Step 3: Configure the Drive and Connect the Motor and Encoder to the Drive
This section covers the minimum drive settings and connections to allow the motor to move. Refer to
the drive manual for additional information about drive parameters and signal information.

1.  Power on the drive and configure the drive for position control mode. These parameters differ
depending on the drive. Refer to the drive manual for information about how to set drive
parameters.

¢  Panasonic Minas A—Set parameter PA_r02 to 0 (position control) and parameter
PA_r42 to 3 (step and direction).

*  Panasonic Minas A5—Set parameter PR0.07 to 3 (pulse train + signal).
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2. Ensure that the drive encoder output pulses and electronic gear parameters are set to the default
values:

Panasonic Minas A

a.  Set parameter PA_r44 to 2500 pulses per rev. If you change this from the default value, you
must also change the value specified for the encoder counts per rev in Step 3: Configure the
NI 9512 C Series Module of the Software Installation and Configuration section.

b.  Set parameters PA_r46, PA_r47, and PA_r4B to 10000 and parameter PA_r4A to 0. This sets
any electronic gearing to a 1:1 ratio.

Panasonic Minas A5

a.  Set parameter PR0.08 to 10000. This specifies the number of command pulses for one motor
revolution. If you change this from the default value, you must also change the value specified
for Steps per rev in Step 3: Configure the NI 9512 C Series Module of the Software
Installation and Configuration section.

b.  Set parameter PRO.11 to 2500 pulses per rev. This specifies the number of encoder pulses per
revolution. If you change this from the default value, you must also change the value specified
for the encoder Counts per rev in Step 3: Configure the NI 9512 C Series Module of the
Software Installation and Configuration section by multiplying the specified value by four.

3. Connect the motor and encoder to the drive. Refer to the documentation specific to your drive for
motor and encoder connection information.

@ Tip An incorrectly connected encoder may cause NI SoftMotion to return error -77076
S (NIMCDM_driveReadyNotActiveError). Verify the encoder connections if you see this error.

4. Connect the drive power. Refer to the drive documentation for power connections and
specifications.

5. Apply power to all the hardware once all connections are made and continue to the next section.

Software Installation and Configuration
This section covers installing and configuring the software for the NI 9512 C Series drive interface

module. It assumes that all required software from the What You Need to Get Started section is installed.

Step 1: Install Software on and Configure the NI RT Controller

Complete the following steps to configure the controller and install software on it.

@ Note The Measurement & Automation Explorer (MAX) user interface may not match these steps
exactly depending on which version of MAX you are using.

1. Launch MAX on the development computer by clicking the MAX icon on the desktop, or by
) selecting Start»All Programs»National Instruments»Measurement & Automation.

2. Select the controller under Remote Systems in the Configuration pane. If you do not see the
controller, you may need to disable the firewall on the development computer. Go to
ni.com/info and enter RIOMAXTroubleshoot for more information.

3. Verify that the Serial Number in the General Settings section matches the serial number on the
device.

4. If you do not want to format the disk on the controller, eliminating all installed software and files,
skip to step 14.

5. Set the Safe Mode switch on the controller to the On position.
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16.
17.
18.

19.
20.

Power on the controller. If it is already powered on, press the Reset button on the controller to
reboot it.

Right-click the controller under Remote Systems in the Configuration pane in MAX and select
Format Disk.

(Optional) Enable the Keep Network Settings checkbox if you want to retain the same target name
and IP address.

Click Format to start formatting the disk.

When MAX finishes formatting the disk, set the Safe Mode switch to the Off position and click
OK.

. Select the System Settings tab and type a descriptive name for the system in the Hostname field.

(Optional) Complete this step only if the target has an empty IP address (0.0.0.0). Select the
Network Settings tab and select DHCP or Link Local from the Configure IPv4 Address list to
assign an IP address or select the Static to specify a static IP address in the IPv4 Address section.

Click Save on the toolbar and let MAX reboot the system.

When the new system name appears under Remote Systems, expand the controller item in the tree,
right-click Software, and select Add/Remove Software.

Select a recommended software set that includes NI-RIO 3.4.0 or later.

Note If you are using the NI SoftMotion Module 2010 SP1 or earlier, also select LabVIEW
NI SoftMotion Module Scan Engine Support from the list.

Click Next.
Select LabVIEW NI SoftMotion Module from the add-ons list.

Click Next to install the selected software on the controller. Click Help if you need information
about installing recommended software sets.

When the software installation completes, click Finish to reboot the controller.
Close MAX.

Step 2: Creating a Project and Adding an NI SoftMotion Axis
Complete the following steps to create a LabVIEW project.

1.
2.

Launch LabVIEW by selecting Start»All Programs»National Instruments»LabVIEW.

Click the Empty Project link in the Getting Started window to display the Project Explorer
window. You can also select FilesxNew Project to display the Project Explorer window.

Select Help and make sure that Show Context Help is checked. You can refer to the context help
throughout the tutorial for information about items on the block diagram.
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4. Right-click the top-level project item in the Project Explorer window and select New»Targets
and Devices from the shortcut menu to display the Add Targets and Devices dialog box. Refer to
Figure 18 for more information.

{5 Project Explorer - Untitled Project 1 * = |-E
File Edit Miew Project Operate Tools Window Help
=11 [ @ o]

Items | Files

B Targets and Devices...

Save

Save Az,

Save All (this Project)

View »
Find Items with Ne Callers

Find Missing ltems

Find Items Incorrectly Claimed by a Library
Find Project ltems...

Expand &l
Collapse All

Properties

Figure 18. Adding a New Target
Make sure that the Existing target or device radio button is selected.
Expand Real-Time CompactRIO.
Select the CompactRIO controller to add to the project and click OK.

®© N W

If you have LabVIEW FPGA installed, the Select Programming Mode dialog box appears. Select
Scan Interface to put the system into Scan Interface mode.

(&)

Tip Use the CompactRIO Chassis Properties dialog box to change the programming mode in an
existing project. Right-click the CompactRIO chassis in the Project Explorer window and select
Properties from the shortcut menu to display this dialog box.

9. Click Discover in the Discover C Series Modules? dialog box if it appears.

10. Click Continue.

11. Right-click the controller item in the Project Explorer window and select Properties from the
shortcut menu to display the RT Target Properties dialog box. Select Scan Engine from the
Category list to display the Scan Engine page.
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12.

13.

15.

Set the Scan Period to 10 ms or lower, then click OK to close the RT Target Properties dialog

box.

If you did not reformat the CompactRIO device in Step 1: Install Software on and Configure the
NI RT Controller, expand the real-time target. If an axis already exists on the target, right-click the
axis and select Remove from Project, or temporarily associate it with different hardware using the
Axis Manager dialog box. You cannot associate two axes with the same hardware device. Refer to
Figure 20 to view a project with an axis on the target.

Right-click the controller item in the Project Explorer window and select New»NI SoftMotion
Axis from the shortcut menu to open the Axis Manager dialog box, shown in Figure 19.

Click Add New Axis to create an NI SoftMotion axis associated with the NI 9512 module. Axes
are automatically bound to an available module. You can double-click the axis name to rename the
axis and give it a descriptive name.

& Axis Manager
Axis Name Bound Hardware
fixis 1 Mod1 (Slat 1, NI 9512)
Add Mew Axis l [ Change Einding ] [ Delete Axis ] [ Maowve Up ] Miove Dawn
’ OF, l ’ Cancel l ’ Help
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16. Click OK to close the Axis Manager dialog box. The new axis is added to the Project Explorer

window.

E Note You cannot associate more than one axis with the same C Series module.
When you have finished these steps your LabVIEW project should look similar to the image in
Figure 20.

£ Project Explorer - Untitled Project 2 * [Z]@
File Edit Wiew Project Operate Tools Window Help
[heSHe | x & 0 Q||| 8 b | |
Items | Fies
=+ [l Project: Untitled Praject 1
- B My Computer
{ . Dependencies
"%, Build Specifications
2 [ cRIO-9012(10.0.67.48)
R chassis (cRIO-9104)
-0k Axis 1 (Modi (Slak 1, NI 9512))
i~ "' Dependencies
@ Build Speciications
Figure 20. Project Explorer Window with Modules in Scan Interface Mode
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Step 3: Configure the NI 9512 C Series Module

Complete the following steps to configure the axis I/O settings for use with the Panasonic Minas A or
Minas A5 drive.

1. Right-click the axis in the Project Explorer window and select Properties from the shortcut menu
to open the Axis Configuration dialog box.

Figure 21 shows the parts of the Axis Configuration dialog box for NI 9512 C Series module.

ﬁ Axis Configuration
General Settings Trajectory Spline Stepper
+
a0 Ll
Limits & Home Capture Encoder
I — 0 —
Digital /0
Jr _/_
—_—
Drive Enable Compare
SN
Figure 21. Axis Configuration Dialog Box
@ Note The Axis Configuration dialog box user interface may not match this image exactly

depending on which version of the LabVIEW NI SoftMotion Module you are using.

2. On the General Settings page set the Loop Mode to Closed-Loop.
~ 3. Click the Encoder button and configure the Units and Counts Per Unit.
ﬂ“" a. Make the following changes in the Active State section:

e Set the Line State for A to High.

¢ Set the Line State for B to Low.

e Set the Line State for Index to High.
b. In the Index Reference Criteria section set the Line State for A and B to Inactive.
c.  Type rev in the Units text box.
d.  Set the Counts per rev to the correct value based on your encoder resolution.

@ Note NI SoftMotion uses x4 encoding, so the encoder resolution needs to be converted to
quadrature counts per revolution before entering the information into the Axis Configuration dialog
box. If your encoder does not supply resolution in quadrature counts per revolution, determine
quadrature counts per revolution by multiplying the encoder resolution in encoder lines or periods by

four. Encoder counts per revolution is also referred to as counts per index. For example, a 500 line
encoder has 2,000 quadrature counts per revolution.
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When you are finished the Encoder Settings page will look similar to Figure 22.

Section Display Units
LUnits

Encoder Yelocity rev i
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Encoder
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Lo o ® O B__'—I_
Index P
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[ OF ] [ Cancel ] [ Apply ] [ Help

Figure 22. Axis Configuration Encoder Page

settings:

a.  Set Output Mode to Step and Direction.

Set Output Type to Differential.

b
c. Set Active State to Low.
d

Click the Stepper button to open the Stepper page. Configure the stepper output and steps per rev

Set Steps Per rev depending on the encoder resolution. For example, if you are using an
encoder with 2500 pulses per revolution, set Steps Per rev to 2500.

When you are finished the Stepper Settings page will look similar to Figure 23.

Stepper
Stepper Outpuk
Section Active Inactive
Cutput Type Ackive State
Stepper Differential - Low v o
Pasition Errar Qutput+
COM
Correction Profile Units Steps Per rev
Vs
rey 2500, 000000 s Output-
= com
Cutput Mode
Forward Reverse
(%) Step and Direction
Step
O Clockwise | Counterclockwise Diraction
[ OF ] [ Cancel ] [ Apply ] [ Help

Figure 23. Axis Configuration Stepper Page

e. Inthe Position Error section, change the Position Error Limit to an acceptable value for
your system. Exceeding the specified position error limit causes NI SoftMotion to disable the
drive and turn off the Drive Enable signal.
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5. Click the Digital I/O button to open the Digital I/O page and map the following status inputs.

a.  Map DI 1 to Servo/Drive Ready. This signal is active when the drive is enabled.

1) Double-click the text in the Mapping column and select Servo/Drive Ready from the
dropdown list.

2) Ensure that the DI 1 settings match the following:
¢ Input Type—Sourcing
e Active State—On
«  Digital Filter—50 ps

b.  Map DI 2 to In-Position. The In-Position signal from the drive is active when the current
position is within a user-specified distance from the target position. This is a drive setting.

1) Double-click the text in the Mapping column and select In-Position from the dropdown
list.

2) Ensure that the DI 2 settings match the following:
*  Input Type—Sourcing
*  Active State—On
*  Digital Filter—50 ps
c.  Map DI 3 to Drive Fault/Alarm. When the Drive Fault/Alarm signal is active, the module
does not generate command signals.
1)  Double-click the text in the Mapping column and select Drive Fault/Alarm from the
dropdown list.
2) Ensure that the DI 3 settings match the following:
e  Input Type—Sourcing
*  Active State—Off
*  Digital Filter—50 ps
d. (Optional) Configure a digital output to use for the Alarm Clear signal, if required. Position
command drives often require an Alarm Clear signal from the module to the drive. This signal
clears the alarm or fault outputs on the drive. This functionality is not available using a

mappable digital output. However, you can use a digital output to implement this functionality
in your code. Complete the following steps to use a digital output as an Alarm Clear output:

1) Determine the required pulse time and active state for the Alarm Clear signal. This
information is in the specifications for the position command drive.

2) Select an available digital output.

3) Configure the digital output Active State, Safe State, and Output Type as required by
the drive.

4) Inyour application VI add code to pulse the digital output line for the appropriate amount
of time to clear the alarm output. Do not clear the alarm on the drive until the alarm
condition is resolved.

@ Note If you are configuring a digital output to use as the Alarm Clear signal, you must connect the
configured output from the J5 screw terminal connector to the drive Alarm Clear signal on the J4
screw terminal connector.
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When you are finished the Digital I/O Settings page will look similar to Figure 24.
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NI 9930 Motion

Figure 24. Axis Configuration Digital 1/0 Page

Open the Trajectory page and enable the In-Position checkbox. This allows the In-Position input
to be used as a criteria for move complete. When this signal is included in the move complete
criteria, the move is only complete if the In-Position signal is active.

Click the Drive Enable button and configure the Drive Enable output settings.

a. Place a checkmark in the Enable checkbox.

b.  Set Output Type to Sinking.

c.  Set Active State to On.

d.  Set Safe State to Off.

Complete the following additional steps if you do not have limits and home connected at this time:
a. Open the Limits & Home page.

b. Inthe Forward Limit and Reverse Limit sections ensure that the settings match the

following:

Note These configuration settings disable limits for initial setup and testing purposes. National
Instruments recommends connecting and enabling limits in your final application.
¢ Clear the Enable checkbox from both Forward Limit and Reverse Limit.

¢ Set the Active State for both Forward Limit and Reverse Limit to Off. This prevents
a limit warning even though limits are turned off.

c.  Open the Home section and clear the Enable checkbox.

Configure any additional I/O settings according to your system requirements, such as position
compare or position capture signals.

Click OK to close the Axis Configuration dialog box.

Right-click the controller item in the Project Explorer window and select Deploy All to deploy
the axis information.

Click Apply in the Conflict Resolution dialog box when it appears.

Select File»Save Project to save the project.
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Step 4: Enable and Test the Drive Using LabVIEW

Use the Interactive Test Panel to test and debug your motion system and configuration settings on the
selected axis. With the Interactive Test Panel you can perform a simple straight-line move and monitor
feedback position and position error information, move and I/O status information, change move
constraints, get information about software errors and faults, and view position or velocity plots of the
move.

Complete the following steps to test your setup after configuring the axis using the Axis Configuration
dialog box.

1. Right-click the axis in the Project Explorer window and select Interactive Test Panel from the
shortcut menu.

2. On the Move tab set Target Position to 25 revolutions.

On the Move Constraints tab set Velocity to 1 revolution/sec. Using the encoder counts per
revolution and stepper steps per revolution values specified in this tutorial the motor will move
25 revolutions at 60 RPM. Click the Help button for detailed information about the items available
in this dialog box.

4. Click the Enable button to enable the drive.
5. Click the Start button on the bottom of the dialog box to start the move with the configured options.
6.  Use the Status and Plots tabs to monitor the move while it is in progress.

Finalize your motion system setup by connecting and configuring additional I/O such as limits as
required by your system using the screw terminal connectors on the NI 9930P accessory.
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NI 9930Y Motion Control Accessory for Yaskawa Servo Drives

The NI 9930Y motion control accessory allows easy connection between the NI 9512 C Series drive
interface module and the Yaskawa Sigma II and Sigma V servo drive.

What You Need to Get Started

You need the following items to get started.

Hardware

U NI9930Y Motion Control Accessory and NI 951x Y-cable.
(NI part number 781822-01)

U NI9512 C Series stepper drive interface module.
(NI part number 779944-01)

U NI real-time controller and chassis that support the RIO Scan Interface.

@ Tip To determine if your controller and chassis support the RIO Scan Interface go to ni.com/
info and enter rdsoftwareversion.

U 24 V power supply (such as the NI PS-15) for the CompactRIO controller.
(NI part number 781093-01)

@ Note Refer to the controller operating instructions for power supply requirements.

U 24 V power supply (such as the NI PS-15) for the NI 9930M. This supply also powers the NI 9512
and any drive 1/O.
(NI part number 781093-01)

@ Note Refer to the NI 9512 Operating Instructions and Specifications and the drive manual to verify
that the selected power supply meets the system requirements.

U Ethernet connection and cable for the CompactRIO controller.

U 50-pin MDR cable to connect the accessory to the drive.
(NI part number 194604-02)

U Yaskawa Sigma-II or Sigma-V position-command servo drive.

@ Note The Yaskawa Sigma-II drive product numbers start with SGDH, and the Yaskawa Sigma-V
drive product numbers start with SGDV.

U Servo motor, encoder, power supply, and associated cables to connect the motor and encoder to the
drive.

Software
1  LabVIEW 2009 SP1 or later

1  LabVIEW 2009 SP1 Real-Time Module or later
U LabVIEW 2009 SP1 NI SoftMotion Module or later
Q

NI-RIO 3.4.0 or later
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Figure 25 shows a simplified connection diagram.

Host Computer

Screw Terminal Connectors

50-pin Cable

NI 951x
Y-Cable

NI RT Controller
(NI cRIO-9014 shown)
and NI 9512 Module

Yaskawa Sigma-II ¢
[ or Sigma-V
Servo Drive
(Sigma-V shown)

+24 V Power Supply
(NI PS-15 Shown)

NI 9930Y Motion
Control Accessory

Figure 25. NI 9930Y Connection Accessory Connections
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Figure 26 shows an overview of the connectors on the NI 9930Y connection accessory.
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Figure 26. NI 9930Y Connection Accessory Connectors
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Hardware Installation and Configuration

Step 1: Set Up the CompactRIO System

Complete the following steps to set up the CompactRIO hardware.

1. Install the real-time CompactRIO controller on the chassis if you are not using an integrated
controller and chassis.

@ Note Write down the controller serial number before installing the controller onto the chassis.
You will be unable to read the serial number after you install the controller.

a.  Make sure that no power is connected to the controller or the chassis.

b.  Align the controller with the chassis as shown in Figure 27.

1 Controller 4 Reconfigurable Embedded Chassis
2 Captive Screws 5 Grounding Screw
3 Controller Slot

Figure 27. Installing the Controller on the Chassis (Eight-Slot Chassis Shown)

c.  Slide the controller onto the controller slot on the chassis. Press firmly to ensure the chassis
connector and the controller connector are mated.

d. Using a number 2 Phillips screwdriver, tighten the two captive screws on the front of the
controller.
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2. Connect the controller to a power supply and an Ethernet network on the same subnet as the
development computer. Refer to the controller operating instructions for information about wiring
the controller to the power supply and Ethernet network.

@ Note Do not plug in or turn on any power to the system until after you complete Step 3: Configure
the Drive and Connect the Motor and Encoder to the Drive.

3. Install the NI 9512 module in slot 1, 2, 3, or 4 of the chassis.
Step 2: Connect the NI 9930Y Connection Accessory

The NI 9930Y connection accessory contains connections for the NI 9512 C Series module, the
Yaskawa Sigma-II or Sigma-V servo drive, and a 24 V power supply for NI 9512 module and drive I/O.

1. Connect the NI 9512 module to the NI 9930Y J3 connector using the NI 951x Y cable.
2. Connect the NI 9930Y J2 connector to the drive CN1 connector using the 50-pin MDR cable.

3. Connect a 24 V power supply to the Vsup and COM terminals on the NI 9930Y accessory J6
connector. Figure 26 shows the location of the power supply input.

4. Connect pin 15 (P-OT - Forward Drive Prohibit Input) and pin 14 (N-OT - Reverse Drive Prohibit
Input) to pin 13 (COM).

@ Note These configuration settings disable limits for initial setup and testing purposes. National
Instruments recommends connecting and enabling limits in your final application. Refer to the drive
documentation for limit input requirements.

5. Connect any additional I/O, such as limits, DIO, position compare outputs, position capture inputs,
and so on, using the NI 9930Y screw terminal connectors. The J1 and J4 connectors allow
connection to the drive I/O signals, and the J5 connector provides connection to the NI 9512 1/0
signals. Refer to the drive or the NI 9512 module documentation for specific signal connection
requirements.
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Figure 28 shows the screw terminal connector pinouts.

Drive 1/0

[
w

[©)
TN

7502 LHorEALDD

85

NELVA/ROD" IN FSINGIVA ¥Od

sw

NI 9512 1/O

1 SEN Signal Input (SEN)

@

P Operation Input (/P-CON){| |

Reverse Side External Torque Limit Input (/N-CL)
Forward Side External Torque Limit Input (/P-CL)
Alarm Code Output (ALO3)

Alarm Code Output (ALO2)

Alarm Code Output (ALOT)

Alarm Reset (/ALM-RST)

Clear Input (CLR)

Clear Input (/CLR)

Battery For Open Collector Reference (PL1)

12 +24V

Ji

13 COM
Reverse Drive Prohibit Input (N-OT)

Forward Drive Prohibit Input (P-OT)

Torque Reference Input (T-REF)

Speed Reference Input (V-REF)

S-Phase Signal Output (/PSO)*

S-Phase Signal Output (PSO)*

Battery— (BAT-)

Battery+ (BAT+)

Rotating Detection Output— (/TGON-)

Rotating Detection Output+ (/TGON+)

24 +24 V

* Sigmal-Il Drive Only

J4

25 COM
Position Compare

Position Capture

+5V Out (NI 9512)

D022 DDDD

ZEEEEEEEEN

| @

DD DDDD

ZEEEEEEEEN

[[[]@

com|| |

DI 0 (NI 9512)

DO 1 (NI 9512)

DO 0 (N1 9512)

Home

Reverse Limit

Forward Limit

36 +24V

J5

DD DDDD

o 111

© MNational Instruments Corporation

Figure 28. NI 9930Y I/0 Connectors

39

NI 9930 Motion Control Accessories User Guide




Step 3: Configure the Drive and Connect the Motor and Encoder to the Drive
This section covers the minimum drive settings and connections to allow the motor to move. Refer to
the drive manual for additional information about drive parameters and signal information.
1. Configure the drive for position control mode by setting parameter Pn000 to n.0010. This
parameter is the same for the Sigma-II and Sigma-V drive.
2.  Ensure that the drive encoder output pulses and electronic gear parameters are set to the default
values:
Yaskawa Sigma-II
a.  Set parameter Pn200 to n.0000.
b.  Set parameter Pn202 to 4 and parameter Pn203 to 1. This specifies a one to four ratio of steps
to counts.

c.  Set parameter Pn201 to 2048. This is the maximum allowable value for this parameter when
you are using an incremental encoder. If you change this value, you must also change the value
specified for the encoder Counts per rev in Step 3: Configure the NI 9512 C Series Module
of the Software Installation and Configuration section by multiplying the value specified here
by four.

Yaskawa Sigma-V

a.  Set parameter Pn20E to 4 and parameter Pn210 to 1. This specifies a one to four ratio of steps
to counts.

b.  Set parameter Pn212 to 2048. If you change this value, you must also change the value
specified for the encoder Counts per rev in Step 3: Configure the NI 9512 C Series Module
of the Software Installation and Configuration section by multiplying the value specified here
by four.

3. Connect the motor and encoder to the drive. Refer to the documentation specific to your drive for
motor and encoder connection information.

@ Tip An incorrectly connected encoder may cause NI SoftMotion to return error -77076
S (NIMCDM_driveReadyNotActiveError). Verify the encoder connections if you see this error.

4.  Connect the drive power. Refer to the drive documentation for power connections and
specifications.

5. Plug in the hardware once all connections are made and continue to the next section.

Software Installation and Configuration

This section covers installing and configuring the software for the NI 9512 C Series drive interface
module. It assumes that all required software from the What You Need to Get Started section is installed.

Step 1: Install Software on and Configure the NI RT Controller

Complete the following steps to configure the controller and install software on it.

@ Note The Measurement & Automation Explorer (MAX) user interface may not match these steps
exactly depending on which version of MAX you are using.

1. Launch MAX on the development computer by clicking the MAX icon on the desktop, or by
) selecting Start»All Programs»National Instruments»Measurement & Automation.

2. Select the controller under Remote Systems in the Configuration pane. If you do not see the
controller, you may need to disable the firewall on the development computer. Go to
ni.com/info and enter RIOMAXTroubleshoot for more information.
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10.

11.

12.

13.

14.

15.

16.
17.
18.

19.
20.

Verify that the Serial Number in the General Settings section matches the serial number on the
device.

If you do not want to format the disk on the controller, eliminating all installed software and files,
skip to step 14.

Set the Safe Mode switch on the controller to the On position.

Power on the controller. If it is already powered on, press the Reset button on the controller to
reboot it.

Right-click the controller under Remote Systems in the Configuration pane in MAX and select
Format Disk.

(Optional) Enable the Keep Network Settings checkbox if you want to retain the same target name
and IP address.

Click Format to start formatting the disk.

When MAX finishes formatting the disk, set the Safe Mode switch to the Off position and click
OK.

Select the System Settings tab and type a descriptive name for the system in the Hostname field.

(Optional) Complete this step only if the target has an empty IP address (0.0.0.0). Select the
Network Settings tab and select DHCP or Link Local from the Configure IPv4 Address list to
assign an IP address or select the Static to specify a static IP address in the IPv4 Address section.

Click Save on the toolbar and let MAX reboot the system.

‘When the new system name appears under Remote Systems, expand the controller item in the tree,
right-click Software, and select Add/Remove Software.

Select a recommended software set that includes NI-RIO 3.4.0 or later.

Note If you are using the NI SoftMotion Module 2010 SP1 or earlier, also select LabVIEW
NI SoftMotion Module Scan Engine Support from the list.

Click Next.
Select LabVIEW NI SoftMotion Module from the add-ons list.

Click Next to install the selected software on the controller. Click Help if you need information
about installing recommended software sets.

When the software installation completes, click Finish to reboot the controller.
Close MAX.

Step 2: Creating a Project and Adding an NI SoftMotion Axis
Complete the following steps to create a LabVIEW project.

1.
2.

Launch LabVIEW by selecting Start»All Programs»National Instruments»LabVIEW.

Click the Empty Project link in the Getting Started window to display the Project Explorer
window. You can also select FilexNew Project to display the Project Explorer window.

Select Help and make sure that Show Context Help is checked. You can refer to the context help
throughout the tutorial for information about items on the block diagram.
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4. Right-click the top-level project item in the Project Explorer window and select New»Targets
and Devices from the shortcut menu to display the Add Targets and Devices dialog box. Refer to
Figure 29 for more information.

{5 Project Explorer - Untitled Project 1 * = |-E
File Edit Miew Project Operate Tools Window Help
=11 [ @ o]

Items | Files

B Targets and Devices...

Save

Save Az,

Save All (this Project)

View »
Find Items with Ne Callers

Find Missing ltems

Find Items Incorrectly Claimed by a Library
Find Project ltems...

Expand &l
Collapse All

Properties

Figure 29. Adding a New Target
Make sure that the Existing target or device radio button is selected.
Expand Real-Time CompactRIO.
Select the CompactRIO controller to add to the project and click OK.

®© N W

If you have LabVIEW FPGA installed, the Select Programming Mode dialog box appears. Select
Scan Interface to put the system into Scan Interface mode.

(&)

Tip Use the CompactRIO Chassis Properties dialog box to change the programming mode in an
existing project. Right-click the CompactRIO chassis in the Project Explorer window and select
Properties from the shortcut menu to display this dialog box.

9. Click Discover in the Discover C Series Modules? dialog box if it appears.

10. Click Continue.

11. Right-click the controller item in the Project Explorer window and select Properties from the
shortcut menu to display the RT Target Properties dialog box. Select Scan Engine from the
Category list to display the Scan Engine page.
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12.

13.

15.

Set the Scan Period to 10 ms or lower, then click OK to close the RT Target Properties dialog

box.

If you did not reformat the CompactRIO device in Step 1: Install Software on and Configure the
NI RT Controller, expand the real-time target. If an axis already exists on the target, right-click the
axis and select Remove from Project, or temporarily associate it with different hardware using the
Axis Manager dialog box. You cannot associate two axes with the same hardware device. Refer to
Figure 31 to view a project with an axis on the target.

Right-click the controller item in the Project Explorer window and select New»NI SoftMotion
Axis from the shortcut menu to open the Axis Manager dialog box, shown in Figure 30.

Click Add New Axis to create an NI SoftMotion axis associated with the NI 9512 module. Axes
are automatically bound to an available module. You can double-click the axis name to rename the
axis and give it a descriptive name.

& Axis Manager
Axis Name Bound Hardware
fixis 1 Mod1 (Slat 1, NI 9512)
Add Mew Axis l [ Change Einding ] [ Delete Axis ] [ Maowve Up ] Miove Dawn
’ OF, l ’ Cancel l ’ Help

Figure 30. Axis Manager Dialog Box

16. Click OK to close the Axis Manager dialog box. The new axis is added to the Project Explorer

5

window.

Note You cannot associate more than one axis with the same C Series module.
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When you have finished these steps your LabVIEW project should look similar to the image in
Figure 31.

£ Project Explorer - Untitled Project 2 * E]@

File Edit Yiew Project

Operate  Tools Window Help

EECT IR 9 o] &F W

Items

Files

= Tg;l, Project: Untitled Project 1
= B My Computer
i 55 Dependencies
‘% Build Specifications
cRIO-9012 {10.0.67.48)
+ [ Chassis (cRIC-9104)
i (83 Axis 1 (Modl (Slot 1, NI 9512))
: _-E' Dependencies
‘% Build Specifications

Figure 31. Project Explorer Window with Modules in Scan Interface Mode
Step 3: Configure the NI 9512 C Series Module

Complete the following steps to configure the axis I/O settings for use with the Yaskawa Sigma II or
Sigma V drive.
1.

Right-click the axis in the Project Explorer window and select Properties from the shortcut menu
to open the Axis Configuration dialog box.

Figure 32 shows the parts of the Axis Configuration dialog box for NI 9512 C Series module.

£ xds Co nfiguration

General Settings

Sr

X]

Trajectory
=

Stepper
L~ — Cf
Limits & Home

Spline

Capture

Encoder

ar T =
Drive Enable Compare

) (e

Figure 32. Axis Configuration Dialog Box
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@ Note The Axis Configuration dialog box user interface may not match this image exactly
depending on which version of the LabVIEW NI SoftMotion Module you are using.

2. On the General Settings page set the Loop Mode to Closed-Loop.
~ 3. Click the Encoder button and configure the Units and Counts Per Unit.
ﬂ‘f a. Make the following changes in the Active State section:

e Set the Line State for A to High.

e Set the Line State for B to High.

¢ Set the Line State for Index to High.
b. In the Index Reference Criteria section set the Line State for A and B to Inactive.
c.  Type rev in the Units text box.
d. Set the Counts per rev to the correct value based on your encoder resolution.
@ Note NI SoftMotion uses x4 encoding, so the encoder resolution needs to be converted to
quadrature counts per revolution before entering the information into the Axis Configuration dialog
box. If your encoder does not supply resolution in quadrature counts per revolution, determine
quadrature counts per revolution by multiplying the encoder resolution in encoder lines or periods by

four. Encoder counts per revolution is also referred to as counts per index. For example, a 500 line
encoder has 2,000 quadrature counts per revolution.

When you are finished the Encoder Settings page will look similar to Figure 33.

Encoder
Section Display Units Active State
Uriits Line State A B Index A | | |
Encoder Yelocity rev i I (OB ORNO] —I_

Laow @ B @ B___| L
Counts Per rev :
8192.00000(% Index — L

Index Reference Criteria

Encoder Yelocity e St a g
1000000 [+| countsfs

Active »

Inactive ® ®

[ OF ] [ Cancel ] [ Apply ] [ Help

Figure 33. Axis Configuration Encoder Page

@ ™ 4.  Click the Stepper button to open the Stepper page. Configure the stepper output and steps per rev
settings:

a.  Set Output Mode to Step and Direction.
b.  Set Output Type to Differential.
Set Active State to Low.

d.  Set Steps Per rev depending on the encoder resolution. For example, if you are using an
encoder with 2048 pulses per revolution, set Steps Per rev to 2048.
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When you are finished the Stepper Settings page will look similar to Figure 34.

|
Stepper
Stepper Oukpuk
Saction Ackive Inactive
e output Type Active State
Differential ] Low ~| Vi
Position Errar ouputs
................... COM
Correction Profile Units Steps Per rev
------------------- W+
rev 2043,000000 = Cutput—
= COoM
Qukput Mode
Forward Reverse
(%) Step and Direction
Stap
O Clockwise | Counterclockwise Diraction
[ K ] [ Cancel ] [ Apply ] l Help

Figure 34. Axis Configuration Stepper Page

e. In the Position Error section, change the Position Error Limit to an acceptable value for
your system. Exceeding the specified position error limit causes NI SoftMotion to disable the
drive and turn off the Drive Enable signal.

5. Click the Digital I/O button to open the Digital I/O page and map the following status inputs.

a. Map DI 1 to Servo/Drive Ready. This signal is active when the drive is enabled.

1) Double-click the text in the Mapping column and select Servo/Drive Ready from the
dropdown list.

2) Ensure that the DI 1 settings match the following:
*  Input Type—Sourcing
*  Active State—On
* Digital Filter—50 ps
b. Map DI 2 to In-Position. The In-Position signal from the drive is active when the current
position is within a user-specified distance from the target position. This is a drive setting.

1)  Double-click the text in the Mapping column and select In-Position from the dropdown
list.

2) Ensure that the DI 2 settings match the following:
¢  Input Type—Sourcing
e Active State—On
« Digital Filter—50 ps
c.  Map DI 3 to Drive Fault/Alarm. When the Drive Fault/Alarm signal is active, the module
does not generate command signals.

1)  Double-click the text in the Mapping column and select Drive Fault/Alarm from the
dropdown list.

2)  Ensure that the DI 3 settings match the following:
¢ Input Type—Sourcing
*  Active State—Off
«  Digital Filter—50 ps
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d. (Optional) Configure a digital output to use for the Alarm Clear signal, if required. Position
command drives often require an Alarm Clear signal from the module to the drive. This signal
clears the alarm or fault outputs on the drive. This functionality is not available using a
mappable digital output. However, you can use a digital output to implement this functionality
in your code. Complete the following steps to use a digital output as an Alarm Clear output:

1) Determine the required pulse time and active state for the Alarm Clear signal. This
information is in the specifications for the position command drive.

2) Select an available digital output.
3) Configure the digital output Active State, Safe State, and Output Type as required by

the drive.

4) Inyour application VI add code to pulse the digital output line for the appropriate amount
of time to clear the alarm output. Do not clear the alarm on the drive until the alarm
condition is resolved.

@ Note If you are configuring a digital output to use as the Alarm Clear signal, you must connect the
configured output from the J5 screw terminal connector to the drive Alarm Clear signal on the J1

screw terminal connector.

When you are finished the Digital I/O Settings page will look similar to Figure 35.

DIO{MDR Pin4) | Mot Mapped

In-Position

DO 0 {DSUE Pin 113 | Mot Mapped
DO 1 {DSUB Pin 53 | Mot Mapped

Pin Mapping

DI1{DSUBPRINE) | Servo/Drive Ready

D1 3 Settings

Input Type

Sourcing

Active State
OFf

Digital Filker
S0us

Digital I/0

Active Inactive
Vaup i External Egei;:al

Clreuit

l

Axig I, Axie 11
Hardware | WCOM  Hardware Y coM
Ok ] [ Cancel ] [ Apply ] [ Help

v [P

a.
b.  Set Output Type to Sinking.

c. Set Active State to On.
d. Set Safe State to Off.
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Figure 35. Axis Configuration Digital 1/0 Page

6.  Open the Trajectory page and enable the In-Position checkbox. This allows the In-Position input
to be used as a criteria for move complete. When this signal is included in the move complete
criteria, the move is only complete if the In-Position signal is active.

7.  Click the Drive Enable button and configure the Drive Enable output settings.
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8.
5

10.
11.

12.
13.

Complete the following additional steps if you do not have limits and home connected at this time:
a.  Open the Limits & Home page.

b. Inthe Forward Limit and Reverse Limit sections ensure that the settings match the
following:

Note These configuration settings disable limits for initial setup and testing purposes. National
Instruments recommends connecting and enabling limits in your final application.

. Clear the Enable checkbox from both Forward Limit and Reverse Limit.

*  Set the Active State for both Forward Limit and Reverse Limit to Off. This prevents
a limit warning even though limits are turned off.

c.  Open the Home section and clear the Enable checkbox.

Configure any additional I/O settings according to your system requirements, such as position
compare or position capture signals.

Click OK to close the Axis Configuration dialog box.

Right-click the controller item in the Project Explorer window and select Deploy All to deploy
the axis information.

Click Apply in the Conflict Resolution dialog box when it appears.
Select File»Save Project to save the project.

Step 4: Enable and Test the Drive Using LabVIEW

Use the Interactive Test Panel to test and debug your motion system and configuration settings on the
selected axis. With the Interactive Test Panel you can perform a simple straight-line move and monitor
feedback position and position error information, move and I/O status information, change move
constraints, get information about software errors and faults, and view position or velocity plots of the
move.

Complete the following steps to test your setup after configuring the axis using the Axis Configuration
dialog box.

1.

o ¢

5.
6.

Right-click the axis in the Project Explorer window and select Interactive Test Panel from the
shortcut menu.

On the Move tab set Target Position to 25 revolutions.

On the Move Constraints tab set Velocity to 1 revolution/sec. Using the encoder counts per
revolution and stepper steps per revolution values specified in this tutorial the motor will move
25 revolutions at 60 RPM. Click the Help button for detailed information about the items available
in this dialog box.

Click the Enable button to enable the drive.
Click the Start button on the bottom of the dialog box to start the move with the configured options.

Use the Status and Plots tabs to monitor the move while it is in progress.

Finalize your motion system setup by connecting and configuring additional 1/O such as limits as
required by your system using the screw terminal connectors on the NI 9930Y accessory.
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Additional NI 9930 Accessories Connector Pinouts

This section contains pinouts for the 37-pin Dsub connector to the NI 9512 module and the MDR

connectors to the drive for each NI 9930 accessory.
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Figure 36. NI 9930P I/0 Connectors
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Figure 37. NI 9930M 1/0 Connectors
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Alarm Reset (/ALM-RST) | [45|20| | PG Frequency Dividing Output C-Phase (/PCO)
Reverse Rotation Stroke End | |44[19]| | PG Frequency Dividing Output C-Phase (PCO)
Reverse Drive Prohibit Input (N-OT) | [43]|18| | Battery For Open Collector Reference (PL3)
Forward Drive Prohibit Input (P-OT) | [42[17| | NC
P Operation Input (/P-CON) | [41[16] | NC
Servo ON Input (/S-ON) | [{40]|15| | Clear Input (CLR)
Alarm Code Output (ALO3) | [39]14| | Clear Input (/CLR)
Alarm Code Output (ALO2) | [38]|13| | Battery For Open Collector Reference (PL2)
Alarm Code Output (ALO1) | [37|12| | Reference Code Input (/SIGN)
PG Dividing Output B-Phase (/PBO) | [36/11]| | Reference Code Input (SIGN)
PG Dividing Output B-Phase (PBO) | [35/10| | NC
PG Dividing Output A-Phase (/PAO) | [34|9 | | Torque Reference Input (T-REF)
PG Dividing Output A-Phase (PAO) | |33] 8 | | Reference Pulse Input (/PULS)
Servo Alarm Output— (ALM-) | |32] 7 | | Reference Pulse Input (PULS)
Servo Alarm Output+ (ALM+) [ |31] 6 NC
Servo-Ready Output— (/S-RDY-) | [30] 5 Speed Reference Input (V-REF)
Servo-Ready Output+ (/S-RDY+) | |29] 4 | | SEN Signal Input (SEN)
Rotating Detection Output— (/TGON-) | |28| 3 | | Battery For Open Collector Reference (PL1)
Rotating Detection Output+ (/TGON+) | |27] 2 COM
Speed Match Detection Output— (/V-CMP-) | |26] 1 COoM

* Sigmal-Il Drive Only

J2 - Sigma-II or Sigma-V Connector

Figure 38. NI 9930Y I/0 Connectors
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Related Documentation

The following documents contain additional information that you may find helpful. All referenced
documents ship with the product and are available at ni . com/manuals.

e Operating instructions for the controller and C Series modules.
*  Applicable drive manual.

e Getting Started with NI 951x C Series Modules and LabVIEW—Use this document to learn
about using the NI 951x modules with LabVIEW, including information about the
LabVIEW NI SoftMotion Module. To access this document, select Start»All Programs»
National Instruments»LabVIEW»LabVIEW Manuals»
Getting_Started_NI_951x_Modules_LabVIEW.pdf.

e LabVIEW NI SoftMotion Module Help—Use this help file to learn about using the NI SoftMotion
Module in LabVIEW including information about function blocks and using the NI SoftMotion
Module with the LabVIEW Project. To access this help file from LabVIEW, select Help»
LabVIEW Help, then expand the LabVIEW NI SoftMotion Module book on the Contents tab.

Worldwide Support and Services

The National Instruments Web site is your complete resource for technical support. At ni.com/
support you have access to everything from troubleshooting and application development self-help
resources to email and phone assistance from NI Application Engineers.

Visitni.com/services for NI Factory Installation Services, repairs, extended warranty, calibration,
and other services.

Visitni . com/register toregister your National Instruments product. Product registration facilitates
technical support and ensures that you receive important information updates from NI.

A Declaration of Conformity (DoC) is our claim of compliance with the Council of the European
Communities using the manufacturer’s declaration of conformity. This system affords the user
protection for electromagnetic compatibility (EMC) and product safety. You can obtain the DoC for
your product by visiting ni.com/certification. If your product supports calibration, you can
obtain the calibration certificate for your product at ni . com/calibration.

National Instruments corporate headquarters is located at 11500 North Mopac Expressway, Austin,
Texas, 78759-3504. National Instruments also has offices located around the world to help address your
support needs. For telephone support in the United States, create your service request at ni . com/
support and follow the calling instructions or dial 512 795 8248. For telephone support outside the
United States, visit the Worldwide Offices section of ni.com/niglobal to access the branch office
Web sites, which provide up-to-date contact information, support phone numbers, email addresses, and
current events.

LabVIEW, National Instruments, NI, ni.com, the National Instruments corporate logo, and the Eagle
logo are trademarks of National Instruments Corporation. Refer to the Trademark Information at
ni.com/trademarks for other National Instruments trademarks. Other product and company
names mentioned herein are trademarks or trade names of their respective companies. For patents
covering National Instruments products/technology, refer to the appropriate location: Help»Patents
in your software, the patents . txt file on your media, or the National Instruments Patent Notice
atni.com/patents. Refer to the Export Compliance Information at ni . com/legal/
export-compliance for the National Instruments global trade compliance policy.

© 2012 National Instruments Corporation. All rights reserved. 373384A-01 Jan12
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